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Quick-start tutorial

IN THIS CHAPTER

e Exercise 1: Displaying and
exploring your data

* Exercise 2: Finding a site for a
new school

* Exercise 3: Finding an alternative
route to the new school site

With Spatial Analyst you can easily perform spatial analysis on your data.
You can provide answers to simple spatial questions, such as “How steep is
it at this location?” or “What direction is this location facing?”, or you can
find answers to more complex spatial questions, such as “Where is the best
location for a new facility?” or “What is the least-cost path from A to B?”
When used in conjunction with ArcMap, Spatial Analyst provides a compre-
hensive set of tools for exploring and analyzing your spatial data, enabling
you to find solutions to your spatial problems.

Tutorial scenario

The town of Stowe, Vermont, USA, has experienced a substantial increase
in population. Demographic data suggests this increase has occurred due to
families with children moving to the region, taking advantage of the many
recreational facilities located nearby. It has been decided that a new school
must be built to take the strain off the existing schools, and as a town
planner you have been assigned the task of finding the potential sites.

Spatial Analyst provides the tools to find an answer to such spatial prob-
lems. This tutorial will show you how to use some of these tools and will
give you a solid basis from which you can start to think about how to solve
your own specific spatial problems.
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It is assumed that you have installed the Spatial Analyst
extension before you begin this tutorial. The data required
is included on the Spatial Analyst installation disk (the
default installation path is ArcGIS\ArcTutor\Spatial, on the
drive where the tutorial data is installed). The datasets were
provided courtesy of the State of Vermont for use in this
tutorial. The tutorial scenario is fictitious, and the original
data has been adapted for the purpose of the tutorial.

The datasets are:

Dataset Description

Elevation Raster dataset of the elevation of the arca

Landuse Raster dataset of the landuse types over the
area

Roads Feature dataset displaying linear road
network

Rec_sites Feature dataset displaying point locations
of recreation sites

Schools Feature dataset displaying point locations
of existing schools

Destination Feature dataset displaying the destination

point for use in finding the shortest path

In this tutorial you will first explore your data to learn
more about it and to understand its relationships. Then, you
will find suitable locations for the new school, based on the
fact that it is preferable to locate close to recreational
facilities for ease of access to these places for the children,
and it is also important to locate away from existing
schools to spread their locations over the town. You also
want to avoid steep slopes and certain landuse types.
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Once you have found the best sites, you will examine these
locations to see which is potentially the most suitable. You
will then examine the data to see if any problems may arise
from building the school in the chosen location.

This tutorial is divided into exercises and is designed to let
you explore the functionality of Spatial Analyst at your
own pace.

* Exercise 1 shows you how to display and explore your
data using the functionality of ArcMap and Spatial
Analyst. You will add and display your datasets, high-
light values on the map, identify locations to obtain
values, examine a histogram, and create a hillshade.

* Exercise 2 helps you to find the best location for a new
school by creating a suitability map. You will derive
datasets of distance and slope, reclassify datasets to a
common scale, weight those that are more important to
consider, then combine the datasets to find the most
suitable locations.

» Exercise 3 shows you how to find an alternative route—
the least-cost, or shortest path—for a road to the new
school site.

Copies of the results obtained from each exercise are stored
in the Results folder on your local drive where you in-
stalled the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial\Results).

You will need about one hour of focused time to complete
the tutorial. However, you can perform the exercises one at
a time if you wish, saving your results along the way when
recommended.
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Exercise 1: Displaying and exploring your data

You should explore your data to understand it and to identify
relationships. Understanding your data and recognizing
relationships will enable you to more accurately prepare

your data for analysis.

In this exercise, you will open ArcMap and add the Spatial
Analyst toolbar to your ArcMap session. You will then
explore your datasets using functionality within ArcMap

and Spatial Analyst.

Starting ArcMap and Spatial Analyst

1. Start ArcMap by either double-clicking a shortcut
installed on your desktop or using the Programs list in

your Start menu.

2. Click OK to open a new empty map.

= _ArcMap (%]

— Start uzing Archdap with

far various geographic regions.

é i An existing map:

Templates provide ready-to-uze layouts and base maps

Browsze for maps...
C:hapatialhS patial_T utarial mxd

™ Immediately add data
[~ Do nat show this dialog again

2]

3. Click View, point to Toolbars, and click Spatial Analyst.

QUICK-START TUTORIAL

[\

98]

b in b enu

Ele Edt |%iew Insert Selection Tools Window Help

m [Drata Visw
(2 Lapout View

Zoom Data 3

Zoaom Lapout 3

Eookmarks »

Tookhars 4 |T I ain Menu
E Table Of Contents |T Standard
|7 Status Bar Tools

Dverflow Labels |T Ciram

Idertify Fesults... Layout
E Scrollbars Spatial Analyst
e Effects

Editor

The Spatial Analyst toolbar is added to your ArcMap

session.

Spatial Analyst

Spatial Analyst * | [Layer: I

Enabling the Spatial Analyst toolbar
. Click the Tools menu.
. Click Extensions and check Spatial Analyst.
. Click Close.
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Adding data to your ArcMap session

L.

W

Click the Add Data button on the Standard toolbar.

Standard

DEES| 5 E@AX | | [Fm 5
|

. Navigate to the folder on your local drive where you

installed the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial, on the drive where the tutorial
data is installed).

. Click elevation, press and hold down the Shift key, then

click landuse, rec_sites, roads, and schools.
Click Add.

Add Dzta

Mame: |e\evatian; landuze; rec_sites. shp: roads.shp: schools, shp Add

j Cancel

L

Shaow of ype: IDatasets and Layers [*lur]

o
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The datasets are added to the ArcMap table of con-
tents as layers.

*

B £ Lapers
B M schadls
®
Bl M rec_sites

@
B M roads
B M landuse
WALUE
(mj]
m:
| K
4
[}
6
| b
E M elevation
Yalue
High : 4361

Low: 438

Displaying and exploring data

You will now explore the display capabilities of ArcMap by
changing the symbology of some of the layers.

L.

Right-click landuse in the table of contents and click
Properties.

E £ Layers
= 0 schoals

®

E1 0 rec_sites
®

E 0 roads

IRy
| [ElE - oy
= * Bemove
= Open Attribute Table
= Joinz and Relates »
= @ Zoaom Ta Layer
= @Q Zoom Ta Raster Resolution
= ele Yisible Scale Rangs 3

Set Data Source..

l Save As Laver File...
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2. Click the Symbology tab. You can also change the color and properties of symbols via
All landuse categories are currently drawn using cell the table of contents.
values as the Value Field and in random colors. You will | 6. Click the point representing schools in the table of
change the Value Field to be more meaningful and contents.
change the color of each symbol to show a more
appropriate color for each landuse on the map. =
. . . £ £F Lapers
3. Click the Value Field dropdown arrow and click landuse. B & schook
4. Double-click each symbol and choose a suitable color to E B rer_sites
represent each landuse type. o
5. Click OK. 7. Scroll to the School 2 symbol and click it.
8. Click the color dropdown arrow and click a color.
2 3 9. Click OK.
Layer Properties
General| Souce | Extent| Display - Symbclony | Fieks |
Show: —
U 3 | Draw raster assigning a color to ach value
Ll
Stretched Walue Field Color Sct
[IN—J [ ([ ) E
Symbol [ <VALUE> [ Label [ Count |
I <l other values> <all ather values>
<Heading> Landuse
I Sarienlhige 25054
L Mo Calor | pd 28
0o Insitional gg;gA L + +
= 71722 Sehoot2 agtars e
L 2157
|| 12281
.ﬂ Defau: Colors | “,fim‘ "MBM1
Display MoData as \'I . . ) gm_l=IIIIIIIIII
| m ] s Min Colora
| EEEEEEEEEEEE | | ool | oo | Moast  mogedz  iessetnert w0 Coce_| \
More Colors. . é
The changes you make are reflected in the table of The changes you make are reflected in the table of
contents and in the map. contents and in the map.
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Highlighting a selection on the map

Examining the attribute table gives you an idea of the
number of cells of each attribute in the dataset.

1. Right-click landuse in the table of contents and click
Open Attribute Table.

x|
E £F Layers |
=
[Jac ¥ Bemaove
g g: Open Attribute T able
B Joing and Relates »
M Fo

=1 @ Zoom To Layer
(it @ﬂ Zoom To Raster FResolution

Notice that Forest (value of 6) has the largest count,
followed by Agriculture (value of 5), then Water
(value of 2).

Ed Attributes of landuse
DbjectlD* | Value Count Landuse

» 1 1 234 | Brush/tranzitional
2 2 E2187 [Water
3 3 28 |Barren land
4 4 36034 | Built up
a a 80054 | Agriculure
E E E71722 |Forest
7 7 12241 |Wetlands

Fiecard: il;l 1 _bl!l Show:W Selecledl Recaords [0 out of 7 Selected.)

1M [=1 E3

Optiohs =

2. Click the row representing Wetlands (value of 7).
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ER Attributes of landuse

ObjectiD* | Yalue

Count Landuse

294 | Bruzhstransitional

B2187 W aber

28 |Barren land

36034 | Buil up

25054 | Agriculture

EV1722 | Forest

00—

RIS E ]
| O T | D | —

12241 |\Wetlands

Recornd: ﬂﬂl 1 _>|1| Show:W Selectedl FRecords

This selected set, all areas of Wetlands, is highlighted on

the map.

3. Click the Options button on the Open Attribute Table

dialog box, then click Clear Selection.

Option:

4. Click the Close button to close the Attributes of landuse

table.

.-l

@& Find & Replace...

B Select By Attibutes. .

s0L

Select Al

Switch Selection

Add Field...

Related Tables

[ Create Graph...
Add Table to Layout

Reload Cache

]

Expart...

Appearance...
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Identifying features on the map

1. Click the Identify tool on the Tools toolbar.

2. Click the Rec_site shown in the map below to identify
the features in this particular location.

Note: Your display will not be zoomed in this much; this

is only to show the location of the recreation site to
click.

. Click the Layers dropdown arrow on the Identify
Results dialog box and click All layers.

98]

4. Click the Rec_site again to identify the features in this
particular location for all layers.

5. Expand the tree of each layer to obtain the value for
each layer in this location.

6. Close the Identify Results dialog box.

QUICK-START TUTORIAL

|dentify, Results
Layers |<AII layerss ﬂ
= rlj]: ites LLocation: (477313 806366 225536, 936307
e M ountain Resort Field | Walua | :|
- ads FID_1 20 =
¢ [ MOUNTAIN RESORT RD | Shape Faint
- landuse FID 315
CBS ARER 0
- elevation PERIMETER 0
= 1519 AP 30021
SITE_MAME Stowe Mountain Fesort
FIPS_CODE 15040
ALT_MAME
S_ADDRESS 5781 Mountain Road ;I

Using Spatial Analyst to explore your data

You will now create a histogram from the landuse layer
and a hillshade from the Elevation layer to gain more of an
understanding of the nature of the landscape.

Setting the analysis properties

Before you use Spatial Analyst, you should set up the
analysis options, stating the working directory, the extent,
and the cell size for your analysis results. These settings
are specified in the Options dialog box.
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1. Click the Spatial Analyst dropdown arrow and click
Options.

|Spat\a\ Analyst = | Layer: Ielevation j Jﬁ iy
n Distance 4
Diensity....
Interpolate to Raster »
Surface Analysiz 3
Cell Statistios...

Meighborhoaod Statistics...

Zonal Statishics.

Reclazzify

Fiaster Calculator..

Convert »

B

2. Specify a working directory on your local drive in which
to place your analysis results. For example, type
c:\spatial to create a folder called spatial on your C:\
drive for use throughout this tutorial.

Click the Extent tab.

98]

4. Click the Analysis extent dropdown arrow and click
Same as Layer “landuse™.

The extent of all subsequent resulting datasets will be
the same as the landuse layer.

18

General |Extent| Cell Size |

c:hapatialt

‘wiorking directory:

Analysis mazk: |<N0ne> vl D”'l

Analyziz Coordinate System

& Analysis output will be saved in the same coordinate
zpstemn az the input [or first razter input if there are
multiple inputs).

' Analysis output will be saved in the same coordinate
zyztem as the active data frame.

¥ Display warming meszage if razter inputs have to be
projected during analyzis operation.

Gereral  Extent | Cell Sizel

Same as Layer "landuze" *

Top: | 231342 353
Left: | 471090083 Right: 4546E5.083
Bottorr: | 205342 353

Shiap externt b |<N0ne> VI @l

Analyziz extent:

a8 I Cancel |
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5. Click the Cell Size tab.

6. Click the Analysis Cell Size dropdown arrow and click
Same as Layer “clevation™.

7. Click OK on the Options dialog box.
This will set the cell size for your analysis results to be at
a 30-meter resolution, the largest cell size of your
datasets.

Examining a histogram

1. Click the Layer dropdown arrow and click landuse.
2. Click the Histogram button.

Spatial Analpst |

Spatial Analyst ~ | Layer: Ilanduse

The histogram displays the number of cells of each type
of landuse.

3. Close the Histogram.

QUICK-START TUTORIAL

Creating a hillshade

Creating a hillshade from elevation data and adding trans-
parency gives you a good visual impression of the terrain
and can greatly enhance the display of your map.

1. Click the Spatial Analyst dropdown arrow, point to
Surface Analysis, and click Hillshade.

Spatial Analyst (=]
|Spatia| Analyst * | Layer. IIandusE j 2
N Distance »
Drensity. .

Interpolate to Raster »

Contaur...
Cell Statistics Slope.

Meighborhood Statistics.. Aszpec
Zonal Statistics. ..

Wiewshed

CutFill..

Feclassify
Fiaster Calculatar...
LConvert »

Options...

2. Click the Input surface dropdown arrow and click
elevation. Leave the defaults for all other options.

Hillzhade [ x]
Input suiface: elevation - 5 —9
Azimuth: il
Altibude: liéﬁ
™ Modsl shadows
Z factor: |—1
Output cell sizs: |73U
Output raster: <Temparan: EI
Cancel
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3. Click OK on the Hillshade dialog box.

The result of the Hillshade function is added to the map
as a new layer.

o e D
=
I
% -
¥ &
=
-
£

i

All results from analysis functions are femporary. If you
want to make any result available for future use, you
should make the dataset permanent.

4. Right-click the created hillshade layer and click Make
Permanent.

5. Navigate to the folder on your local drive where you set
up your working directory (C:\Spatial).

6. Type “Hillshade” in the Name text box.

7. Click the Save as type dropdown arrow and click ESRI
GRID.

8. Click Save.

Note: A copy of Hillshade can be found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex 1\Hillshade on the
drive where the tutorial data is installed.

20

B £ Layers
= schaals

i3

E b rec_sites
-
= b roads
= Hillsh g
- y 55 Copy
H ¥ Remove
Lt Open Attibute Table
=] landu Jains and Relates »

L
= @ Zoom To Layer

18 4R Zoom To Raster Resolution
B
e
I Set Data Source...

Wisible Scale Range »

= Save Az Laper File.

H Froperties...

5
Save As
Lok in: I[:l Spatial ﬂ EI Ql“lrj{l
Mame: IHl\Ishade —e
Save as type: IESHI GRID :IJ Cancel |
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Applying transparency
You will now make the landuse layer transparent so the

Hillshade can be seen through it.

1. Click Hillshade of elevation in the table of contents and
drag the layer below the landuse layer.

l2

E £F Layers
=] schaals

&

=] rec_sites

@
=] roads
= Hillshade of elevation
Walue
High: 255

Lawe: 0
=] landuse
Landusze
[ Agriculture
[] Barren land
[ Brushstranzitional
[ Built up
I Forest
i ater

[ Wwetlands _o
=] elevation

Walue

2. Click View on the Main menu, point to Toolbars, and
click Effects.

. Click the Layer dropdown arrow and click landuse.

98]

4. Click the Adjust Transparency button and move the
scroll bar up to 30 percent transparency.

The Hillshade layer can now be seen underneath the
landuse layer, giving a vivid impression of the terrain.

QUICK-START TUTORIAL

tain Menu

File Edit |View |nsert Selection Tools Window Help

ﬁ Drata Wiew
m Layout Wiew
Zoom Data »
Zoom Lapaut »
Eookmarks r
Toolbars » |T b ain bdenu
{El Table Of Contents [v  Standard
|7 Statug Bar |T Tools
Dverflow Labels... |T Diraw
Identify Fesults... Layout
E Scrollbars |T Spatial Analyst
[B5 Fulers
q_ Eiuielars Editar
Grid Georeferencing
Dimenzioning

['ata Frame Properties...
Data Frame Tools

Utility M etwork Analyst
Yersioning

Graphics

Edit Cache
Customize...

Wiew Source

Laper: |landuse _"J Y ] _\/K_l_

Tranzparency
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Exploring your data gives you a useful basis of informa-
tion that will help you during your analysis. For ex-
ample, you need to know the different landuse types and
their distribution over an area, as well as their relative
importance, in order to decide how much weight each
should have in a suitability model. Alternatively, you
need to know how rugged the terrain is so you know to
include slope as a factor in determining the least-cost
path.

Having explored your data, you are now in a position to
begin to find suitable locations for the new school.

First, you will need to remove all the layers used in this
exercise.

5. Click the top layer in the table of contents to highlight
it. Press and hold the Shift key and click all other layers.

6. Right-click one of the layers in the table of contents and
click Remove.
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1%

B £F Layers

o C e ——
. L B2 Gopy
DA!E

1B <% Zaom To Layer
MF
=~
[ Save fe Laver File...

=] Hillzh
- -Vlg' Broperties. .
High 255

Vizghle Scale Range b

Low: 00

- = elevation
Value
High : 4361

Low : 438

All layers will be removed from the ArcMap data
frame.

This exercise showed you how to display and explore your
data. In the next exercise you will use the Spatial Analyst
functions to find a potential site for a new school. You can
continue on with the tutorial or close ArcMap and continue
at a later date. There is no need to save the map document
at this point.

Note: To save your work at any time, click the File menu
and click Save As. Navigate to the location where you set
up your local working directory (C:\Spatial), specify a
filename for the map document—Spatial Tutorial—and
click Save. Simply open Spatial Tutorial. mxd when you
wish to continue with the tutorial. You will, however, be
prompted when it is appropriate to save the map document.
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Exercise 2: Finding a site for a new school in Stowe, Vermont, USA

In this exercise you will find suitable locations for a new
school. The four steps to produce such a suitability map are

outlined below.

Derive Datasets

J

Decide which datasets you need as

Step 1: inputs. The datasets you will use in
Input Datasets this exercise are displayed to the
l right.
Step 2: Derive datasets. Create data from

existing data to gain new informa-
tion.

Step 3: Reclassify cach dataset to a com-
Reclassify mon scale—for example, 1-10—

Datasets giving higher values to more suitable

l attributes.

Step 4: Weight datasets that should have
Weight and more influence in the suitability

Combine model if necessary, then combine

Datasets them to find the suitable locations.

Your input datasets in this exercise are Landuse, Elevation,
Recreation Sites, and Existing Schools. You will derive
slope, distance to recreation sites, and distance to existing
schools, then reclassify these derived datasets to a common
scale from 1-10. You will then weight them according to a
percentage influence and combine them to produce a map
displaying suitable locations for the new school. The
diagram to the right shows the process you will take.

QUICK-START TUTORIAL

Elevation Recreation Schools

Landuse

Reclassify

Reclassify  Reclassify

\\//

Weight and Combine Datasets

Recllassd‘y
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Step 1: Inputting datasets

1. Click the Add Data button on the Standard toolbar.

Standard

DEEEF BRX |0 P f2er 5
1

2. Navigate to the folder on your local drive where you
installed the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial, on the drive where the tutorial
data is installed).

. Click elevation, then click and hold down the Ctrl key
and click landuse, rec_sites, and schools.

4. Click Add.

98]

- O

Name [ehewaticn: landuse: rec_sites ship; schools. shp Add

Cancel

Show of type IDalasets and Lapers (%) j

Each dataset is added to the ArcMap table of contents
as a layer.

24

Setting the analysis properties

Set up the analysis options like you did in Exercise 1.

1. Click the Spatial Analyst dropdown arrow and click
Options.

2. Specify a working directory on your local drive in
which to place your analysis results. Type c:\spatial to
create a folder called spatial on your C:\ drive.

. Click the Extent tab.

98]

4. Click the Analysis Extent dropdown arrow and click
Same as Layer “landuse™.

5. Click the Cell Size tab.

6. Click the Analysis Cell Size dropdown arrow and click
Same as Layer “elevation™.

7. Click OK on the Options dialog box.

UsiNng ARcGIS SpaTIAL ANALYST



Step 2: Deriving datasets

Deriving data from your input datasets is the next step in
the suitability model. You will derive the following:

» Slope from elevation
» Distance from recreation sites

» Distance from existing schools

Deriving slope

Since the area is mountainous, you need to find areas of
relatively flat land to build on, so you will take into consid-
eration the slope of the land.

1. Click the Spatial Analyst dropdown arrow, point to
Surface Analysis, and click Slope.

|Spatial Analyst = | Layer Ielevation j @ Hmh
= |
Distance 3
Density...

Interpolate to Raster 3

LContaour...

Cell Statistics. ..

MNeighborhood Statiztics... Azpect...

Zonal Statigtice, Hillshade:..

Beclassify... Yiewshed...
CutFill...

Faster Calculatar....

LConwert »

Options....

2. Click the Input surface dropdown arrow and click
clevation.

QUICK-START TUTORIAL

3. Type slope in the Output raster text box to permanently
save your output slope dataset to the location of your
working directory (c:\spatial).

You will use this dataset again in Exercise 3.

Note: A copy of this slope dataset can be found in the
location ArcGIS\ArcTutor\Spatial\Results\Ex2\Slope.

4. Click OK.

2

Slope I
Input surface: Ielevation ﬂ El
Dutput measurement; & [Deges " Percent
£ factar: I 1
Output cell zize: I 30
Clutput raster: |3|0D'B El

Ok I Cancel |

© o

The output slope dataset will be added to your ArcMap
session as a new layer. High values—red arcas—
indicate steeper slopes.
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Deriving distance from recreation sites

In this model, it is preferable that the school be built near
recreational facilities, so you will now calculate the
straight-line distance from Recreation Sites.

1. Click the Spatial Analyst dropdown arrow, point to
Distance, and click Straight Line.

| [elovaton =]

Shaight Line...

2. Click the Distance to dropdown arrow and click
rec_sites.

Leave the defaults for all other options.

26

3. Click OK.

Straight Line [ 7] ]
EXTR 2

—

E—

ok | ceree |

The output distance to the rec_sites dataset will be
added to your ArcMap session as a new layer. Values of
zero indicate the location of a recreation site, with
values—distances—increasing as you move away from
each of these sites.

Using ARcGIS SpaTiAL ANALYST



Note: A copy of this distance to rec_sites dataset can be
found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\recD.

4. Uncheck the box next to Schools to turn off this layer so
you only see the locations of the recreation sites and the
distance to them.

Deriving distance from schools

You will now derive a dataset of distance from existing
schools. It is preferable to locate the new school away from
existing schools to spread out their locations through the
town.

1. Click the Spatial Analyst dropdown arrow, point to
Distance, and click Straight Line.

2. Click the Distance to dropdown arrow and click schools.
Leave the defaults for all other options.
3. Click OK.

Straight Line
Distance to:
M aximum diztance:
Output cell size:

™ Create diection: |<TEmDGTEW> @l
|<Temporaw> @l
I(Temporar}l) D’*l

o]
®

™ Create allacation:

Output raster

Cancel |

QUICK-START TUTORIAL

The output distance to schools dataset will be added to
your ArcMap session as a new layer.

4. Check the box next to the schools layer to turn it back
on and uncheck the box next to rec_sites to turn this
layer off so you only see the locations of the schools and
the distance to them.

Note: A copy of this distance to schools dataset can be
found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\schD.
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Step 3: Reclassifying datasets

You now have the required datasets to find the best location Spaiial Anals!
for the new school. The next step is to combine them to | B Pk
find out where the potential locations can be found. E::::e '

Interpolate to Raster 3

In order to combine the datasets, they must first be set to a S face s
common scale. That common scale is how suitable a Ol Statistos.
particular location—each cell—is for building a new school. Neighborhcod Stalsis..
You will reclassify each dataset to a common scale, within Sonal Satet

the range 1-10, giving higher values to attributes within BT O

Raster Caloulator...

cach dataset that are more suitable for locating the school:

Convert »
* Reclassify slope Dpters.
* Reclassify Distance to recreation sites
* Reclassify Distance to schools p)
* Reclassify landuse Reclassify
. . Input raster: IS\ope ﬂ EI

ReCIaSSIfylng SIope Reclass field: IVaIue j
It is preferable that the new school site be located on [-Set valuss to reclassity
relatively flat ground. You will reclassify the Slope layer, fees |1“BW el = s ©
giving a value of 10 to the most suitable slopes—those with FHTIES e R Uriaue_|
the lowest angle of slope—and 1 to the least suitable e e sy |
slopes—those with the steepest angle of slope. %%955599'?%55515‘9 2 (3 oeke Enie|
1. Click the Spatial Analyst dropdown arrow and click load. | Sawe. |

RGCIaSSIfy [~ Change miszing values to NoData
2. Click the Input raster dropdown arrow and click Slope. Dutput raster: [{Terporary> =
3. Click Classify. ok | _ Coreol |
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4. Click the Method dropdown arrow and click Equal 7

Interval.
5. Click the Classes dropdown arrow and click 10. o [Sre 5 =
. Reclass field: alus -
6. Click OK. T =
[0ld values T Nbw values <] Chassitp |
0 |
4 71116109 154223038 4 | Unique |
154223035 - 231334557 8§
231334557 - 308446075 7 i
308446075 - 385557594 B = M
e AT I B De\alaEanEsl
| Eﬂ..ﬁ:
Meart 14056040
STl TR I™ Change missing values ta NoDats
Output raster: | Temporan,> EI
i ; i % g a El Ok | Cancel
Bl & 3 ¥ 7 & &
- i al &5 g & 4 g
’ The output reclassified slope dataset will be added to your
L S tariee e w-';iws Toasbssst ArcMap session as a new layer. Locations with higher
Do Hescx I dete sl ey Los X

values—Iless-steep slopes—are more suitable than locations
You want to reclassify the Slope layer so steep slopes with lower values—steeper slopes.
are given low values, as these are least suitable for
building on.

7. Click the first New value record in the Reclassify dialog
box and change it to a value of 10. Give a value of 9 to
the next New value, 8 to the next, and so on. Leave
NoData as NoData.

8. Click OK.
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Note: A copy of this reclassified slope dataset can be found
in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\slopeR.

Reclassifying distance to recreation sites

The school should be located near recreational facilities.
You will reclassify this dataset, giving a value of 10 to
areas closest to recreation sites—the most suitable loca-
tions—giving a value of 1 to areas far from recreation
sites—the least suitable locations—and ranking the values
in between. By doing this you will find out which areas are
near and which areas are far from recreation sites.

1. Click the Spatial Analyst dropdown arrow and click
Reclassify.

patial Analyst

‘Spal\alAna\ySl - | Laper: Ielevation j ?P; H]]lh
Distance »
Density....
Interpolate to Raster 3

Surface Analysis
Cell Statistics...

Meighborhood Statistics...

Zonal Statistics...
Raster Calculatar. .
Canvert »

Options:

2. Click the Input raster dropdown arrow and click
Distance to rec_sites.

3. Click Classify.
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Iriput raster [Distance to rec_sites Ra=2

Rieslass fiekd [Fvale &l

Set values to reclassil

0ld walues ‘ MNew values - Classify... 9

0.000000 - 1348, 72793 1

RN e L] | e
SRS B A TE Y

TRt ri W i A Entry
B4R T T7E T ETATHTIEE S - —I

1) | »
Load... Save. I

™ Change missing values to NaDats

|<Tampmary> EI
Cancel

Delete Enires

Output raster

4. Click the Method dropdown arrow and click Equal
Interval.

5. Click the Classes dropdown arrow and click 10.
6. Click OK.

2[x
= | Classifioation Statist
Method:  [EqualInterspl =l Count 602862
Minimun: 0
Classest 10 | Masimum 13382.2558
D ata Enchusion Sunw 2565633020
an: 428935714
= Use ustom il e e Esclusion Standard Deviation 2655 B8081
I= | belovscustorm it
& Sampl
Shan dlass o vehies [ e custom s e By aroed Gteisies
Columrs: [100 = W S Pl (W Sl Breakvaues %
F = §® B ® 8 3 & B =& 133922558
1000 & B o5 0N & B 2 08 267645117
1 PO A= 1B { Y 1 I 4014 67675
100004
5000
334556306 689112702 1D036EM1G 133823558
I Sriep breehs ko caia valizs I lsg £t
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You want to locate the school near recreational facilities,
so you will give higher values to locations close to
recreational facilities, as these are the most desirable.

. As you did when reclassifying the Slope layer, click the
first New value record in the dialog box and change it to
a value of 10. Give a value of 9 to the next New value, 8
to the next, and so on. Leave NoData as NoData.

. Click OK.

7
Input raster. IDislanca to rec_gtes j Bﬁ‘l
Reclass field: IVaIue j
i~ Set values ta reclassify
0ld walues | Mew valles - Clazzify |
0 i ;
R L I_ riqwe_|
2B97 5250 - 4046 28838 8
4046 28838 - B9 05117 7 Add Ertry
b295 05117 - BF44 81398 B - —I
o | » Delete Enlriesl
Load.. | Save.. |
I™ Change missing values to MoData
Output raster. |<TEmDﬂfaf}'> @l
0k I Cancel |
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The output reclassified distance to recreation sites
dataset will be added to your ArcMap session as a new
layer. It shows locations that are more suitable for
locating another school. High values indicate more
suitable locations.

Note: A copy of this reclassified distance from recreation
sites dataset can be found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\recR.
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Reclassifying distance to schools

It is necessary to locate the new school away from existing
schools in order to avoid encroaching on their catchment
arcas. You will reclassify the Distance to schools layer,
giving a value of 10 to areas away from existing schools—
the most suitable locations—giving a value of 1 to areas
near existing schools—east suitable locations—and ranking
the values in between. By doing this you will find out
which areas are near and which areas are far from existing
schools.

1. Click the Spatial Analyst dropdown arrow and click
Reclassify.

Distance ]
Denzity....

Interpolate to Raster 3
Surface Analysis 3
Cell Statistics...

Meighborhood Statistics...

Zonal Statistics...

Raster Calculator

Canvert »

Options..

2. Click the Input raster dropdown arrow and click
Distance to schools.

3. Click Classify.
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Reclassify
Inpul raster [Distance to schools ==
Reclass field: [value =l
Set values to reclassif
0ld valuss [ New valuss - Classify

OLA0GAAN - 1685 785548 Y
1652 0048 - S35 5795597 2 Wit |
far et e e o Y
Bi76 SEEG4E 77T TE8E8 Y Add Entiy
[rralle R ek e —I

G e

| »

Delete Enires

Load. Save

™ Change missing values to NoData

Output raster. I<Temporary>

=

Cancel

4. Click the Method dropdown arrow and click Equal

Interval.

5. Click the Classes dropdown arrow and click 10.

6. Click OK.

i

[TEET- |

[} 2231 87412 2453 94824

T
12695,8224

—
18927 5085

[FET*]

a

1607 A
L3 0
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You want to locate the school away from existing
schools, so you will give higher values to locations
farther away, as these locations are most desirable.

As the default gives high New values—more suitable—
to high Old values—Ilocations farther away from existing
schools—you do not need to change any values this

time.
7. Click OK.

Reclassify

Input raster:

Fieclass figld:

ID\stancE to schools

=l =

IVaIue

r Set values to reclassif

=

0ld values

| Mew values

- | Classify.. |

0- 16592, 783E5

1E3z. 78965 - 3380.5793

Unigue:

3386.5793 - B078.36895

O078.36895 - B7F

115853

Add Enlry

E771.15853 - 046,

04824

LS HESERE R

S

e

3 Delete Entrlesl

Load. Save...

™ Change missing values to NoDiata

Output raster,

|<Tempﬂrary>

=
ok J Cancel |

The output reclassified distance to schools dataset will
be added to your ArcMap session as a new layer. It
shows locations that are more suitable for locating
another school. Higher values indicate more suitable

locations.

QUICK-START TUTORIAL

Note: A copy of this reclassified distance from schools
dataset can be found in the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\schR.
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Reclassifying landuse

At a town planners meeting it was decided that certain
landuse types were better for building on than others,
taking into consideration the costs involved in building on
different landuse types.

You will now reclassify landuse. A lower value indicates
that a particular landuse type is less suitable for building
on. Water and Wetlands will be given NoData as they
cannot be built on and should be excluded.

1. Click the Spatial Analyst dropdown arrow and click
Reclassify.

Spatial Analpst

Spatial Analyst * | Layer Ie\evalion j ?’fp?ﬁ I
Distance »
Density.
Interpolate to R aster 3
Surface &nalysis »
Cell Statistic:s..

Meighborhood Statistics.

Zonal Statistics...

Raster Calculator. .

Canvert »

Optians..

2. Click the Input raster dropdown arrow and click landuse.

3. Click the Reclass field dropdown arrow and click
Landuse.

4. Type the following values in the New values column:
Agriculture—10 Built up—3
Barren land—6 Forest—4
Brush/Transitional—5
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You will now remove the Water and Wetland attributes
and change their values to NoData.

5. Click the row for Water, press the Shift key, click
Wetlands, then click Delete Entries.

6. Check Change missing values to NoData.

All values for Water and Wetlands will be changed to
NoData.

7. Click OK.

Al ES

|nput raster: IIandusa ﬂ EI
Reclass field: ILanduse —ﬂ'——e

— Set values to reclassit
0ld values | ew values | [Elazsifi.. |
Agriculure 10
Earren land 3 Uiz |
Erush/tranzitional 5
Built up 3 4dd Entry |
Forest 4
NoData HoData Delste Entrie:
[
Load... | Save.. |
Iv Change mizsing values to NoDats
Oltput raster: |<Tempo|ary> qu
Ok I Cancel |

(6] (7]
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The output reclassified landuse dataset will be added to
your ArcMap session as a new layer. It shows locations
that have landuse types that are considered to be better
than others for locating the school—higher values
indicate more suitable locations.

8. Right-click Reclass of landuse in the table of contents
and click Properties.

9. Click the Symbology tab.

10. Click the Display NoData as dropdown arrow and click
Arctic White to show NoData values—Water and
Wetlands—in this color.

11. Click OK.

QUICK-START TUTORIAL

Layer Properties

General | Source | Extent | Display  Symbology | Fields |
Shaow:

W ‘ Draw raster assigning a color to each value

Clazsified

Shretched —Walue Field

IVaIue

Color Sch
| {I IMNEE} N -

Symbol | <VALUE>

| Label

I Count I

I <= cther valuzss

<Heading>

<all other values:>
YALUE

3

4

5

E

10

1 | HEmuveVaIuesI

25054
4EBE1E
205

21
59224

Default Colors |

Dizplay Nolrata as

o]

Cancel | Apply

(1)

1)

Note: A copy of this reclassified landuse dataset can be

found in the location

ArcGIS\ArcTutor\Spatial\Results\Ex2\landuseR.
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Step 4: Weighting and combining datasets

After applying a common scale to your datasets, where
higher values are given to those attributes that are consid-
ered more suitable within each dataset, you are ready to
combine them to find the most suitable locations.

If all datasets were equally important, you could simply
combine them at this point; however, you have been
informed that it is preferable to locate the new school close
to recreational facilities and away from other schools. You
will weight all the datasets, giving each a percentage
influence. The higher the percentage, the more influence a
particular dataset will have in the suitability model.

You will give the layers the following percent influence:

(Each percentage is divided by 100 to normalize the
values.)

Reclass of Distance to rec_sites: 0.5 (50%)
(25%)
0.125 (12.5%)
0.125 (12.5%)

1. Click the Spatial Analyst dropdown arrow and click
Raster Calculator.

Reclass of Distance to schools: 0.25
Reclass of landuse:

Reclass of slope:

36

Spatial Analyst

Spatial Analyst = | Layer: | elevation = 2
m Digtance »
Density...
Interpalate ta R aster 3
Surface Analysiz »

Cell Statistics. ..

Meighborhood Statistics...

Zonal Statistics...

Reclazsify...

—0

Carwert »

Options..

2. Double-click Reclass of Distance to rec_sites from the
Layers list to add it to the expression box.

Click Multiply.

Click 0.5.

Click Add.

Double-click Reclass of Distance to schools.
Click Multiply.

Click 0.25.

. Click Add.

10. Double-click Reclass of landuse.
11. Click Multiply.

12. Click 0.125.

13. Click Add.

14. Double-click Reclass of slope.
15. Click Multiply.

© % N v e W
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16. Click 0.125.

17. Click Evaluate to perform the weighting and combining
of the datasets.

ool e] o]

O e e S Y I
i ] e o e e
i i PR O N I

[Feclass of Distance to rec_sites] * 0.5 + [Feclazz of Digtance to zchoolz] * ;I
0.25 + [Reclass of landuse] * 0.125 + [Reclass of Slope of elevation] * 0,125

Raster Calculator

Layers

Distance to rec_sites &
Diztance to schools
elevation

landusze

Reclass of Distance b

[

Evaluate I LCancel | >>|

@

About building expressions |

The output raster dataset shows you how suitable each

location is for locating the new school, according to the

criteria you set in the suitability model. Higher values
indicate locations that are more suitable.

The suitable locations are those areas that are close to
recreation sites, away from existing schools, on rela-
tively flat land, and on certain types of landuse. The
higher weightings set for Distance to schools and
Distance to rec_sites have a powerful influence on
deciding which areas are more suitable than others.

QUICK-START TUTORIAL

18.

19.
20.
21.
22.

24.

25.

Right-click the newly created raster layer in the table of
contents and click Properties.

Click the Symbology tab.
Click Classified from the Show list.
Click the Classes dropdown arrow and click 10.

Scroll to the last three classes, click one, then press and
hold the Shift key and click the other two.

. Right-click the highlighted classes, click Properties for

selected Colors, and click a bright color.

Click the Display NoData as dropdown arrow and click
the color black. This displays values of NoData—Water
and Wetlands—in this color.

Click OK.

Layer Propeties

Genersl | Jource | Extert | Display  Symbology | Fieigs |

Show:
Unigue Val

| Draw raster grouping values into classes

e

- Fiel i
alue e = Equal brterval
Nermalization: [ NONE> =] | | cissces: [10 =] [ Classi:

[ - |

Symbol | Range T Label | =

[ YRS 444975
I 4975555 4975-558
I 5556125 555-6125
] 612567 612567
[ 67-7255

Color Ramp:

B7-7.275

Flip Colors
Flarp Colors

Ll

éEB

Display HoData as -|v|.-

20l |

Properties for all Calors

Reverse Sortin
a 0K, | caed |

Remove Classes

Format Labels
Edit Desrption

® ®
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You decide that there are three main potential areas for
locating the school. They are labeled in the diagram
below.

Area 2

Area 1 Area 3

You should now assess these locations to see which
might be the best location. This should be done in the
field, as well as by examining the data you have on each
potential area.

26. Right-click the output layer in the table of contents and
click Make Permanent.

27. Navigate to the folder on your local drive where you set
up your working directory (c:\spatial).

28. Type Suitability and click Save.

The temporarily created dataset will now be perma-
nently stored on disk.
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Note: A copy of this Suitability dataset can be found in
the location
ArcGIS\ArcTutor\Spatial\Results\Ex2\Suitability.

29. Click the output raster twice slowly. Rename the layer
Suitability.

= roads

S uikahiling

Walue

=]
2253825
W cEs-44

B 4.4-4975
4975 -555

You decide that the best location is somewhere within Area
1, as there are three recreation sites in the neighboring area,
the ski resort being one of them. Also, although you know
that a considerable volume of traffic already uses the
current access road to this potential site, you are involved
in plans for constructing an alternative road to this area,
which will help alleviate the volume of traffic on the
current access road.

30. Click the Schools layer in the table of contents, press
the Ctrl key, and click all other layers except Suitability
(use the scroll bar to move down the table of contents).

31. Right-click one of the highlighted layers and click
Remove.

You have now completed Exercise 2. You can continue on
to Exercise 3, or you can stop and continue later. Which-
ever option you choose, save the map document at this
point. Click the File menu and click Save As. Navigate to
the location where you set up your local working directory
(c:\spatial), specify a filename for the map document—
Spatial Tutorial—and click Save.
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Exercise 3: Finding an alternative access road to the new school site

In this exercise you will find the best route for a new
access road. The steps you might follow to produce such a
path are outlined below, and the steps you will take in this
exercise are diagrammed to the right.

Step 1: Create Source and Cost Datasets

Create the source dataset if necessary. The Source is the
school site in this exercise.

Create the cost dataset by deciding which datasets are
required, reclassifying them to a common scale, weighting,
then combining them.

Step 2: Perform Cost Weighted Distance

Perform cost weighted distance using the Source and Cost
datasets as inputs. The Distance dataset created from this
function is a raster where the value of each cell is the
accumulated cost of traveling from each cell back to the
source.

To find the shortest path, you need a Direction dataset,
which can be created as an additional dataset from the cost
weighted function. This gives you a raster of the direction
of the least costly path from each cell back to the source (in
this exercise, the school site).

Step 3: Perform Shortest Path

Create the destination dataset if necessary. In this exercise,
the Destination is a point at a road junction.

Perform shortest path using the Distance and Direction
datasets created from the cost weighted function.

QUICK-START TUTORIAL

Step 1: Create Source

Source

Step 2: Cost Wei

Step 3: Sh

Destination Distance

and Cost Datasets

ghted Distance

Direction

ortest Path
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Step 1: Creating the source and cost datasets

To find the best route to the potential school site, you will
first need to create the Source dataset (the school site)
from the suitability map, and a Cost dataset, and use these
as inputs into the cost weighted function.

Creating the source dataset

If you want to know how to create the Source dataset,
follow the next 29 steps. Alternatively, click the Add Data
button and navigate to the location where you installed the
tutorial data (ArcGIS\ArcTutor\Spatial). Click Roads, then
click Add. Then, click the Add Data button again and
navigate to ArcGIS\ArcTutor\Spatial\Results\Ex3. Click
School site, then click Add and skip the next 29 steps.

You will first create an empty shapefile in ArcCatalog™,
then digitize the location of the site using the editng tools in
ArcMap.

1. Click the ArcCatalog button on the Standard toolbar.

aﬁn§|x,gx|nn|¢||ﬂua,n4 v[”E‘@h‘?

2. Navigate in the Catalog tree to the folder on your local
drive where you set up your working directory
(c:\spatial).

3. Right-click the Spatial folder, point to New, and click
Shapefile.
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i E

ﬁ Copy  ChkC

B Eooie Gl

¥ Delsts
Rename
FRefresh
Hew

A Search...

PFropeties: ez
= Group Layer

Folder

Personal Geadatabass

4. Type “School_site” for the name of the new shapefile.

5. Click the Feature Type dropdown arrow and click
Polygon to choose the type of feature that will be
created.

6. Click Edit to add spatial reference information to the
shapefile.

Mame: ISchnn\_ st

Feature Type: [Palygon =l

r~ Spatial Referen

Description:

Unknown Coordinate System =

=
4 ¥
I S icials Edi.. 6

™ Coordinates will contain M values. Used to stors 30 data.
I~ Coordinates will containZ valuss. Used to stare raute data.

Cancel
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7. Click Select to use a predefined coordinate system.

Sijpabial Heloioncs Propeilies

Coontinate System |

[T T

Deaks
]
L]

0_— Getect. Sl prmdelred cxnnriale sl
Imgxcet & Coowdinate Tyabem and WY, Zu\du
oot demaies from an eitng geodataret e
1m-n¢uuﬂ.mm i)
Newr Crese 3 naw coodnale system.
e it the properties of s cumendly selacted
coordnate witem.

Set the coemdnain srviem iz Lnkncen.
_I Saren e coctinale etbem 1o a e

8. Click the Projected Coordinate Systems folder, click
State Plane, then click NAD 1983 and scroll to NAD
1983 StatePlane Vermont FIPS 4400.prj.

9. Click Add.

Browse for Coordinate e X
Lok irc I@ NAD 1983 | EI =
@ MAD 1983 SlaleF‘Iane Utah South FIPS 43U3 pii @ MAD 1383 StatePlane s
4B NAD 1383 StatePlane i
@NAD 1983 SlalePIane VIIgII’Ha Maorth FIPS 4501.prj @ MNAD 1983 StatePlane wig
5 MAD 1983 StatePlane Viginia South FIPS 4502 pr 2 NAD 1983 StatePlane Wy
T MAD 1983 StatePlane Washington Moith FIPS 4801 pi A MAD 1983 StatePlane Wi
5 MAD 1983 StatePlane \Washington South FIPS 4502 pri A2 NAD 1983 StatePlane ye
| MAD 1983 StateFlane West Viiginia North FIFS 4701 pi
@NAD 1963 StatePlane West Virginia 5outh FIPS 4702,
T MAD 1983 StateFlane Wisconsin Cential FIFS 4802 pij
T
Marme: [MAD 1903 StatePlane Vemcnt FIPS 4400 pr —9
Show of type:  [Spatial references =l Caricel
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10. Click OK on the Spatial Reference Properties dialog
box.

11. Click OK on the Create New Shapefile dialog box.

A new shapefile called School_site will be created and
added to the Catalog tree.

12. Click File, click Exit to close ArcCatalog, and return to
ArcMap.

13. Click the Add Data button and navigate to the folder on
your local drive where you installed the tutorial data
(the default installation path is
ArcGIS\ArcTutor\Spatial).

14. Click roads.shp.
15. Click Add.

= =] Ealam|ek

2] schonls.shp

Mams: |loads shp Add _@
Show of ype: [ Datasets ard Lapers "] =l Cancel

16. Click the Add Data button again and navigate to the
folder on your local drive where you set up your
working directory (c:\spatial).

17. Click School_site.
18. Click Add.
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19. Click the Zoom In tool on the Tools toolbar and zoom in
on the area that was deemed most suitable (area 1,
circled in yellow below).
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20. Click View, point to Toolbars, and click Editor.

File Edit |View |nsert Selection Tool: Window Help

m [Drata Yiew
m Layout Wiew
Zoom Data »
Zoom Lapaut »
Eookmarks r
Toolbars 4 |7 Main Menu
{El Table O Contents [v | Standard
|T Status Bar Toals
Ovwerflow Labels.. |7 Daw
Identify Fesults... Layout
E Scrollbars |7 Spatial Analyst
(5 Ffers |T Effects
Iﬂ- [Fies
Fifie Geareferencing
Diimensioning

Drata Frame Properties...
[rata Frame Tools

Ultility Metwark Analyst
Yersioning

Graphics

Edit Cache

LCustomize...

YiERSourze

21. Click the Editor dropdown arrow and click Start
Editing.

Editar

Edter
Editor | [ |, - | Task: ICreate Mew

Start Editing

Stop Editing

Save Edits

=L B id Edib Bache

i

fove..
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22. Click c:\spatial (or wherever you specified your working
directory to be) for the folder from which to edit data.

23. Click OK.

24. Click the Task dropdown arrow and click Create New
Feature.

25. Click the Target dropdown arrow and click School _site.

26. Click the Create New Feature dropdown arrow and
click Create New Feature.

Editor = ”T| ﬂ | Target: ISchuUlele Iil |

- ‘ Task: ICleate Mew Feature
L

2|

¢4 Create Mew Feature|

27. Draw a polygon on the screen in the location shown in
the diagram. Click and hold to add a polygon vertex,
drag the cursor, and add another polygon vertex.
Continue until the polygon is complete. Double-click to
close the polygon.

QUICK-START TUTORIAL

28. Click the Editor dropdown arrow and click Stop Editing.
29. Click Yes to save your edits.

Note: A copy of this school_site dataset can be found in the
location ArcGIS\ArcTutor\Spatial\Results\Ex3\source.shp.

Creating the cost dataset

You will now create a dataset of the cost of traveling over
the landscape, based on the fact that it is more costly to
traverse steep slopes and construct a road on certain
landuse types.

1. Right-click the Suitability layer and click Remove.

2. Click the Add Data button and navigate to the folder on
your local drive where you set up your working directory
(c:\spatial).

3. Click slope (the dataset created in exercise 2).

4. Click Add.

5. Click the Add Data button again and navigate to the
folder on your local drive where you installed the

tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial).

6. Click landuse and click Add.
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7. Right-click landuse and click Zoom To Layer. 2. Click the Input raster dropdown arrow and click slope.
" 3. Click Classify.

Fl £ Layers
= School_site
O
= roads 2
B
Copy
E X Remove
e Input rast | | =
= 1 DpenAliibute Table TR [sope =
E Joing and Relates » izt i [valu |
. i@ Zoom Ta Baster Resolution Ol values | New values | Classity 0
Vigible Scale Riange » T G0 - 6 24432 [ =
SetDatas [T 5 Urique |
GRS i EERAG A5 5
Save Az Layer File... 0732573 - 0 577257 4 Add Ertry
B B G737 1 e 5 »
Propeities. O B | Delete Enlres

Load... Save. I

™ Change missing values ko MoData

1. Click the Spatial Analyst dropdown arrow and click Duipul st [{Temzoran =
Reclassity. Carce

Reclassifying slope

Spalial snalyst ¥ | Layerillanduse j B

4. Click the Method dropdown arrow and click Equal

Interval.
Distance 3
Density.. 5. Click the Classes dropdown arrow and click 10.
Interpalate to R aster »
Surface fnalpsiz » 6 Cllck OK
Cell Statishic:s.

Meighborhood Statistics

Zonal Statistics. .

Raster Calculator

Corvert »

Options...
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You want to avoid steep slopes when constructing the
road, so steep slopes should be given higher values in
the Cost dataset.

As the defaults give high values to steeper slopes, you
do not need to change the default New Values.

7. Click OK on the Reclassify dialog box.

The Reclass of slope layer will be added to the table of
contents. It shows locations that are more costly than
others for constructing a road—higher values indicate
the more costly areas that should be avoided.

QUICK-START TUTORIAL

Reclassifying landuse

1. Click the Spatial Analyst dropdown arrow and click
Reclassify.

st

Spatial Analyst « | LaPEIZIIandusa j ﬁ'ﬁ Hmn
Distance 3
Denzity
Interpolate to Raster »

Surface Analyziz

Cell Statistics...

Meighborhood Statistics..

Zonal Statistice..

—O

Raster Caloulatar...

Corrvert [

Options. .
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2. Click the Input raster dropdown arrow and click landuse.

W

Click the Reclass field dropdown arrow and click
Landuse.

4. Click the first New value to edit the values and type in
the following values:

Agriculture—4 Built up—9
Barren land—6 Forest—38
Brush/Transitional—5 Water—10

Higher values indicate higher road-construction costs.
5. Click Wetlands and click Delete Entries.
6. Click Change missing values to NoData.

7. Click OK.
il 3
Input raster: I\anduse ﬂ =
Reclazs field: ILanduse —g——e
r— Set values to reclassify
0ld walues | M walues - [Elzzsifi.. |
Agriculture 4 =
Earren land E Uniaue |
Erush/transitional 3 |
Built up g Add Entry |
Forest a =
kil - | _»l_l Delste Entri I e
Lioad | Save |
¢ Change missing values to MoData
utput raster: |<Tempnra|y> =
0K I Cancel |
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The Reclass of landuse layer will be added to the table of
contents. It shows locations that are more costly than others
for constructing a road, based on the type of landuse.

The NoData value—Wetlands—is currently displayed
transparently so you can see the layers underneath. To
make this value solid, change it to white.

8. Right-click Reclass of landuse and click Properties.
9. Click the Symbology tab.

10. Click the Display NoData as dropdown arrow and click
Arctic White.

11. Click OK.
Properties
General | Soucs | Eent | Display  Symbolosy | Fisids |
Show
T | Draw raster assigning a color to each value
Classified
Stretched Yalue Field | "Colur" hem
|Va\ue Il Mo Color | -]v
ALLE> g g g E E ot
<all ath luess i
oy e AN E N NN
. EmMEECDEE | 5
o s ENEEERN uEls
I EEEEEEEN Bl
[ BEEOOOOO B [ jeests
[kl REOUOODOEEE B
e EEEECCSSENEN
1] ENNEEEEENENN
‘ . ﬂ Add All'Valuzs Add Val More Colors.. fault Colors:
B " Display NoData as 17 @
0K | Cancel | Apphy I
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Combining datasets

You will now combine Reclass of slope and Reclass of
landuse in order to produce a dataset of the cost of building
a road at each location in the landscape, in terms of steep-
ness of slope and landuse type. In this model, each dataset
has equal weighting, so it is not necessary to apply any
weight as we did when finding the suitable location for the
school.

1. Click the Spatial Analyst dropdown arrow and click
Raster Calculator.

2. Double-click Reclass of landuse to add it to the
expression box.

3. Click the Add button.

4. Double-click Reclass of slope to add it to the expression
box.

5. Click Evaluate.

QUICK-START TUTORIAL
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The result is added to your ArcMap session. Locations Step 2: Performing cost weighted distance
with low values identify the areas that will be the least
costly to build a road through. They are displayed in
dark blue in the graphic below.

You will now perform cost weighted distance using the Cost
dataset you just created and the School_site layer (the
source). Using this function, you will create a Distance
dataset where each cell contains a value representing the
accumulated least cost of traveling from that cell to the
school site and a Direction dataset that gives the direction
of the least-cost path from each cell back to the source.
This conceptual process is explained in more detail in
Chapter 7, ‘Performing spatial analysis’.

1. Click the Spatial Analyst dropdown arrow, point to
Distance, and click Cost Weighted.

Spatial Analyst

Staight Line...
Denaity... Allocation

Interpolate to Raster 3

Cost "weighted. ..

Shartest Path...

. Click the output layer in the table of contents to highlight e s ,
it, click again, and rename it Cost. Cell Statsis...

Meighborhood Statistics...

You will now remove all layers except Cost,

Zonal Statistics...

School_site, and Roads. Rechassiy..
. Click Reclass of landuse, press and hold down the Ctrl FRasterCacuter.
key, click Reclass of slope, slope, and landuse. convet ’
Options. ..

. Right-click one of the layers and click Remove.
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2. Click the Distance to dropdown arrow and click
School_site.

. Click the Cost raster dropdown arrow and click Cost.
. Check Create direction.
. Click OK.

whn = W

Oistance to:

Oost raster: Cost .
aximum distance:

Qutput cell zize:

Wﬁl
Wﬁ
Wﬁl

o]

(5]

™ Create allacation:

Output raster.

Cancel |

The Distance and Direction datasets are added to your
ArcMap session as layers.

6. Click the output Distance layer in the table of contents,
click again, and rename it Distance.

7. Click the output Direction layer in the table of contents,
click again, and rename it Direction.
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Step 3: Performing shortest path

You are now almost ready to find the shortest path from the
school site. You have performed cost weighted distance,
creating a Distance dataset and a Direction dataset, using
the school site as the source. However, you will need to
decide on, and then create, the destination point for the
road. As you have already learned how to create a new
shapefile, this destination point shapefile has been created
for you.

1. Click the Add Data button.

2. Navigate to the folder on your local drive where you
installed the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial).

Click Destination and click Add.

Locating the destination point for the road in the position
identified by the Destination shapefile will take much of
the traffic away from the current road and provide a
back route to the area for school buses and other
vehicles.

98]
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4. Click the Spatial Analyst dropdown arrow, point to
Distance, and click Shortest Path.

Diensity. .

Interpalate to Baster
Surface Analysis
Cell Statistics..

Meighborhood Statistics..

Zonal Statistics
Reclassify.

Raster Calculatar...
Corevert

Options..

Straight Line. ..

Allncation
> Cost 'weighted...

5. Click the Path to dropdown arrow and click Destination.

6. Click the Cost distance raster dropdown arrow and click

Distance.

7. Click the Cost direction raster dropdown arrow and click

Direction.

Leave the defaults for the other options.

8. Click OK.

Shortest Path

Path ta:

Cost distance raster:
Cost direction raster:
Fath type:

Clutput features:
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The shortest path is calculated, and the resulting layer is
added to your ArcMap session. It represents the least-
cost path—Ieast cost meaning avoiding steep slopes and
on landuse types considered to be least costly for
constructing the road—from the school site to the road
junction.

9. Click Distance in the table of contents, press the Ctrl
key, and click Direction and Cost.

10. Right-click Cost and click Remove to remove all three
layers.
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AALUE:

[10- 23,804 6063

[ 23.804.6063 - 47 B09.2125
[ 47.609.2125 - 71,413.8188
I 71.413.8188 - 95,218,425
I 55.215.425 - 119,023.031
I 119,023,031 - 142,827 538
I 142,827 638 - 166,632 244
I 166,632,244 - 190,436.85
I 190,436,585 - 214,241 456
I 214,241 456 - 238,046,063

= e _

wal = Lopy

[ Sou E

1 Righ = Group

[ Lo

Doy <& Zoom To Layer

= tUF‘ Visible Scale Flange b
eff——

B Upr Saye ds LavenFle.

E EEF' M Properties...

H = S

UsiNng ARcGIS SpaTIAL ANALYST



Displaying the results : |

. Layer |landuse MG B )
To see exactly where this path should be constructed, you ‘|J ’_T ransparency
will now create a more detailed map. é

Adding the datasets
1. Click the Add Data button on the Standard toolbar.

2. Navigate to the folder on your local drive where you set 30,
up your working directory (c:\spatial).

3. Click Hillshade and click Add.

Note: A copy of this hillshade dataset can be found in
the location
ArcGIS\ArcTutor\Spatial\Results\Ex 1\Hillshade.

4. Click the Add Data button on the Standard toolbar.

5. Navigate to the folder on your local drive where you
installed the tutorial data (the default installation path is
ArcGIS\ArcTutor\Spatial).

6. Click landuse and click Add.

Applying transparency

7. If the Effects toolbar is not already present, click View
on the Main menu, point to Toolbars, and click Effects.

8. Click the Layer dropdown arrow on the Effects toolbar
and click landuse.

9. Click the Adjust Transparency button and move the
scroll bar up to a transparency of 30 percent.
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Changing the default field for landuse

You will now change the value field for the landuse layer so

you can more easily distinguish each landuse type.

L.

Right-click Landuse in the table of contents and click
Properties.

Click the Symbology tab.

3. Click the Value Field dropdown arrow and click

landuse.
Click OK.

Change the color of the symbols in the table of contents
to more appropriate colors for each type of landuse.

. Right-click the symbols representing landuse types in

the table of contents and pick an appropriate color for
each one.

Landuze

Herriea b

= lgnduse ||

i Mo Calar

EDDDDDDDDDDD
.DlDDDQDDDI:
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I TERE T T
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tore Colors...

| oimps
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Zooming in on the area

1. Click the Zoom In tool on the Tools toolbar.

B smm

W mm
EILA

@
Ll
R
o

@ 7

2. Click and drag a rectangle around the location of the
new road to zoom in on this area (the area to zoom to is
highlighted in red on the map below).
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Prop arties

Gef elall Sourcel Selecl\onl D\splayl Symbologyl Fields | Dethition Query  Labels Jo\ns&He\alesl

Lahel Features

Method: Label allthe teatures the same way. -

Al features will be labeled using the options specified.
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 Tent Syrbol
2aBloVyEE Symbol...
- Other Option Pre-defined Label Style
Label Flacement Options... | Seale Aange.. | ’V Label Sty |

oK I Cancel Apply

Label the road network to be able to identify which existing ©
roads may be of use in constructing the new road. The road names are labeled on the map.

1. Right-click Roads in the table of contents and click
Properties.

2. Click the Labels tab.
Check Label Features.

4. Click the Label Field dropdown arrow and click
STREET NAM.

5. Click OK.

Labeling the roads

W
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6. Click the File menu and click Save.

If this is the first time you are saving the map document,
navigate to the location where you set up your working
directory (c:\spatial), specify a filename for the map
document—Spatial Tutorial—and click Save.

This brings you to the end of this tutorial. You have been
introduced to some of the functions of Spatial Analyst,
such as learning how to explore your data, producing a
suitability map, and finding the least-cost path.

You have covered much ground, but there is a great deal
more for you to explore. The rest of this book will provide
you with a guide as you learn how to solve your own
specific spatial problems.
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